GMail

Courtesy of Wikipedia

“Gmail is a free email service developed by Google. Users can access Gmail on the web
and using third-party programs that synchronize email content through POP or IMAP
protocols.”

* Provides each user with 50Gb of storage

* Maximum size of received emails is 50Mb

* Maximum size of sent emails is 25Mb

* Includes scanning filters for spam and malware

May gather data for the use of other services

A user may have several Gmail addresses, e.g. one for important, private
correspondence, one for occasional use that can be “thrown away” if it gets
spammed, one for purchasing, etc.

Gmail may be accessed via a desktop or an internet client.



Gmail in use -
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Get more done
with Gmail
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Go to Google.com/Gmail, select “Create an
Account” and fill in the fields. | chose a
fictitious DOB, for my security.

Once you are in, it’s important to “Control
your account” to eliminate adverts, etc.

< Now more secure, smarter and easier to use -
helping you save time and do more with your
inbox.

Create an account

Google

Create your Google Account

to continue to Gmail

First name Last name

Anne Menzies

Usemame

annetemp @gmail.com

You can use letters, numbers & periods

Confirm

Password

Use 8 or more characters with a mix of letters, numbers &
symbols

Sign in instead

Welcome to Google
®

annetemp74@gmail.com

] Phone number (optional)

We'll use your number for account security. It won't be visible to

others.

Recovery email address (optional)

We'll use it to keep your account secure

Day Month
31 January v

Your date of birth

Year

2000

Just to confirm...

This Google Account is set up to include personalisation features such as
recommendations and personalised ads, which are based on information saved to

your account.

You can choose 'More options' to change your personalisation settings and the info

saved to your account.

More options

Finish setting up your new Google Account - Google Hi Anne, Welcome t...

-
3/

Gender
[ Rather not say

Why we ask for this information

Back

Control your account

Choose what's right for you. Review and adjust
your privacy and security settings at any time.

Google Account




Gmail in Use — Importing Contacts

= M Gma & searchmel - To access the contacts click
b Compose O- c > o on the 3 * 3 dots then
O imbox b rrimen e . promotons select Contacts.
© oo g o et temongonane. v || @ In the left hand menu of
2o T T T the contacts page, select
g - @& Oy crorcomctonmecmmt- e s | T “Import”

R N e o s o From your files select the

7

&
'S

0 .

< Import contacts file you want to use and
o o e To import contacts, select a CSV or vCard file. Learn more CIiCk On Import.

o [ seiccerie | As my original file was

called “Test Group”, a new

-
Q & import conacts “Label” is created with the

YouTube News

<

Gmail Drive To import contacts, select a CSV or vCard file. Learn more

ﬁ Select file Test Group.vcf Sal I Ie nal I le
|— Create contact

Calen Cancel Import
2 Contacts 37
9 Frequently contacted A Labels
@ Duplicates D Genealogy 3 IMPORTED ON 11/25 (3
v Labels O  Imported on 11/ ° Anne GMall I———R: oail.com

D Test Group 3 o Anne icloud I € .cOom
Export

& P + Create label o Anne Tring IR 2 rk.com
©  Print




Gmail in Use — Welcome Email from Google

[ M Gmail Q_ Search mail

Oo- c¢

l— Compose

[J Primary
[J Inbox 1
W Starred

Get started with Gmail
©® Snoozed
> Sent Q Customise your
inbox
B Drafts
v More
Google Community T

Meet

| strongly recommend that you
do use the “Control your
account” option, but I’'m not
going into it at the moment as
there that would be part of a
Security presentation.

= M Gmail

I- Compose

Inbox

Starred

Sent

Drafts

(W]
*
© snoozed
>
B

More

B Start a meeting

E  Join a meeting
Chat

Something's not right.

We're having trouble connecting to
Google. We'll keep trying...

Q_ Search mail - ® @
€ g 0 = 0 & b Tof1
Finish setting up your new Google Account inbox &
Google Ci ity Team I munityteam-nore.. 14:02 (3 minutes ago) Yy 4
tome v
Google

v
"

Hi Anne,

Welcome to Google. Your new account comes with
access to Google products, apps and services.
Here are a few tips to get you started.

0

Control your account

&z




Gmail in Use — Creating an Email

LUMIuTyuur avtuurmt

= M Gmai T
4

/ Subject At the bottom of the

|- compose email, there are options

.
C to.
» v

Inbox )
PR @gmail.com

%X Starred 7 = format; add an
o attachment; insert a link;
add an emoji; insert from
From the Gmail scregn, Google drive; turn on / off
click on Compose — confidential mode and to
1 add a signature. Hovering
In the To field, as you over the symbol will
type, the word To will B ccomns 8 display the option.

disappear Click to activate.

¥~ ~ Sans Serif T~ B T U A~ =~ =

IAl
I'I

Similarly in the Subject

field. MA@@@&E@;’



Microsoft Outlook — Office 365 — Add an Account

Adding a new account in this version is relatively straightforward. This one takes 6
steps to set up a non-standard IMAP account.

N
o

@ Home Send / Receive Ft

2 [ T ) .
E & - W = Options
Email Items~ %'

From File,
select Account

& Outlook

Advanced setup

J

Office 365

MNew Delete
wFavorites
Inbox
Unread Mail
Sent Items
Open & Export
A 2 corum.org

Let me set up my account manually

Connect

N

POP

O

Accoun
admina@u3adacor.

% POP/SMTP

( —|— Add Account
. =7

0
& & O
Outlook.com Exchange Google
IMAP Exchange 2013 Other
or earlier
IMAP Account Settings

neensisessilsecd 3 corum.org

Password

L.2.2.2.2.2.2.2.2.2.2.2.2.2.1

R Outlook

Select ‘Let me set
up my account
manually’

Account successfully added

IZI IMAP
O L .01




Microsoft Outlook — Office 365 — Add an Account

Adding a new standard account in this version is also relatively straightforward.
This one takes 5 steps to set up a GMail account.

N
o

@ Home Send / Receive Ft

= -
M |E @ e e
New  New .
Email Items~ %'

As before, from File, select Account Options

and add account. Type in the email and just O
click on Connect to enter your password

X

MNew Delete
& Outlook
ACCOU nt ] (MQma[I.com
Open & Export
P admina@u3adacor. Advanced options v
B _popssmre
Save Attachments = - @
————
IMAP Account Settings
annetemp3@gmail.com (Mot youT)
R Outlook
Password

ssssssss

Account successfully added

I'z] IMAP

i g Mail.com




Microsoft Outlook — Office 365 — Delete an Account

If you no longer need an account, it’s easy to delete it.

From the File menu click on Account Settings.

@ m Send / Receive F . .

IR R=IE That will display all your accounts.

Er:l"ne:iil It:':\’:' %'

New Bl Select the account to be deleted and click on Remove. You’ll

vl Account Informat| get a warning, but if you’re sure, just continue.

Inbox

Unread Ma I = dacorurm.or

e % IMAP/SMTP i ’

—|— Add Account

% Account Settings

Change settings for this account]

Account " Get the Outlook app for iPh
Settings ~ _ :
Account Settings é

Email Accounts
You can add or remove an account. You can select an account and change its settings.

er Update Password

Email | Data Files | R55 Feeds | SharePoint Lists I Internet Calendars | Published Calendars I Address Books

o New... 3% Repair.. [% Change.. @ SetasDefault(( X Remove | &+ &

MName Type
Q_ﬁcorum.org POP/SMTP (send from this account by default)
|

oo o - .dacorum.org




Microsoft Outlook — Office 365 — Create an EMail

Send / Receive

File Home

M o I 5

-

New  New
Email Items~ 22"

Clicking on New Email will display the mail form

Click on To to bring up the list of contacts. | have
only 2 here as | do not generally use Outlook.

Developer Help

Address Check

Untitled - Message (HTML)
Q Tell me what yf

0 &2 [

Attach Attach Signature
File~ Item~

22

Book MNames

Mames Include

Select Names: Contacts

New Delete
~
o File Message Insert Options Format Text Review
Paste e B I U S
Clipboard - Basic Text
Send Ce
bject I

Search: (@ Mame only () More columns  Address Book

Go Contacts - adm|

| MName Display Name

Select an email and click on “To” to

add it as an addressee.

Use the same method to add to Cc

and / or Bcc. Click on OK, once

you’re finished.

Anne GMail ([mamba453
Anne icloud ([annemenz

Q Anne GMail
® Anne icloud

B

Send

To

Cc

Bee

Coect_TestingD

Anne GMail (mamb

Anne icloud (annen

mn

Anne GMail
C

Anne icoud

a
.,
g | (5

-



Microsoft Outlook — Office 365 — Emails Cont’d

Adding attachments and a Signature. Use the ‘Insert’” menu. Most of the icons are

self-explanatory

To create a
signature, select
Signatures and
click on New

0 =24

k Attach Attach Signature
=3 Filew Item~ =~

Includs

WA,

Members

HETp \_," TEIT e What you wa
Sl |7
[ - l d
heck Attach Attach Signature .
ames Filer Item~ - L
Recent [tems
Fowler - FH.fh_data
YYWwmware-host\Shared H
Fowler - FH.ged
“Ywmware-host\Shared H
Help ¢ Tell me what you want to do

P] Follow Up ~
! High Importa
\L Low Importan)

Anne Comp Sup

Add the

Signatures and Stationery

E-mail Signature | Personal Stationery

required text.

Select signature to edit

Anne Comp Sup

Anne Web Suiior’c

-

To add to the

Anne Menzies
U3A Dacorum Membership Secretary

Anne Web Suppo

Signatures and Stationery

E-mail Signature | Personal Stationery

Select signature to edit

Anne Web Support

Delete

Edit signature
Calibri (Body)

[*lnf] B 1

’Regards

.

u3adacorum.org
'
ks

- email, select
Delete New Save Rename
E‘Etsignm | | | | the name of the
Calibri Body)  [»][11 [+]| B I W | Automatic signatu re
Best wishes
Help Q Tell me what you want to do

@J @IJZ] @ P Follow Up -

| High Import
Attach Attach Signature - mighimportay

Filew Item~ = \l, Low Importan

Includ Anne Comp Sup

Anne Web Support

Subject

Testing

McGivern Malcolm James - 1980 Electoral Record
52 KB

[£)

Testing for U3A Computer Support

Best wishes

Anne Menzies
U3A Dacorum Membership Secretary
u3adacorum.org

Signatures...
- Ancestry.pdf o




Microsoft Outlook — Office 365 — Emails Cont’d

Add images via the Insert menu.

Because 365 is an advanced application, it can be a bit clever. It has automatically

added alternate text to this image.

Bec Anneiclond fannemenzicc@me cnml

Automatic Alt Text

We added alt text to describe your image for
people with vision impairments. If you'd like to
change it, click this bar or right-click the image
and select Edit Alt Text.

Subject Testing

Testing for U3A Computer Support

And the Sent email

~ -

S s

File Home Send / Receive
%2 W

My o Wl &

New  New " Delete Archive
Email Items~ 5?3"

New Delete

I Favorites
Inbox
Unread Mail

Sent ltems

» Search Folders

I & Yz dacorum.o...
Inbox 1228
Sent Items

Deleted ltems

Sent Items - admina@u3adacorum.

Folder View
<_) Reply

% Reply All

— Forward 97

Respond

Search Sent Items

Developer Help Nord]

1 Move to: 2
2 To Manager hd
& Team Email

Quick Steps (]

,O Current Folder -

All Unread By Date v T
v Today
Anne GMail (mamba... ]
Testing 20:06
Testing for USA Computer
v Last Month
‘ann SN Mme.C...
Testing email from Anne's ... 12/05/2020

Testing, including a

CCand

B G100




Microsoft Outlook — Office 365 — Menu Bars

Just some of the menu bars.

Untitled - Message (HTML)

File Insert Options Format Text Review Developer Help @ Tell me what y

B Cexiz= 0| B B8] 02 K

[
Paste E] B T U £ A — — — | == == | Address Check | Attach Attach Signature
- 3 - - - — == Book Mames File~ Item~ -
Clipboard I Basic Text Mames Include

Testing - Message (HTML)

File Messad Format Text Review Developer Help ¢ Tell me what you want to do
@ ﬂIJZ'I [A2] Business Card ~ @ Fd Pictures (‘g Icons |:|:|:|Chart @ Link - [&] Text Box - EDrop Cap~ TT Equation -
ﬁ Calendar F& Online Pictures ﬁa 3D Models ~ &l Screenshot - [:] Bookmark Quick Parts ~ @ Date & Time ) Symbol ~
Attach Outlook Table =
Filer Tem @ Signature - - '-_C‘) Shapes~ I SmartArt fq WordArt - El:] Object 7= Horizontal Lin
Include Tables Illustrations Links Text Symbols

Testing - Message (HTML) Picture Tools
File Message Insert Options Format Text Review Developer Help @ ¢ Tell me what you want to do
-.  B&Color~ § z Picture Border ~ . = O = - A "
EE ~0c B~ | peem| [pvem = _ I—XEI - J |_* _ 1T 3605cm 2
_ E[A Artistic Effects - - &) Picture Effects ~ [ [i5)]
Remaove Corrections £ - L - M= . Alt Wrap Crop 43 1981 cm *
Background - =} G2, Picture Layout ~ T o I:'E Selection Pane Cq- . e -

Adjust Picture Styles M| Accessi... Arrange Size il A

-



Webmail

Webmail is a term that is commonly used in two ways. It’s used to describe web-based email
services like Yahoo Mail and Google’s Gmail but also to describe web-based access to any email
account.

The important part is knowing the web address for your email If you don’t have an address that’s
already web-based, (Gmail, Apple, etc.) and is normally used for a company associated email e.g.
U3ADacorum, i.e. has the same extension as the website. You cannot use web-based emails like
GMail with Webmail.

In a recent Art competition support role, | used to get vast quantities of spam, and used Webmail
to delete them, rather than downloading them all to my computer.

eomal When you log in to Webmail you’ll be

Open your inbox . . .
beny presented with a choice of client.

Roundcube or Horde.
roundcube Q Click on one of them toit and

open source webmail software . .
display your inbox.

m Open my inbox when | log in

Change your webmail client

3khorde



https://mail.yahoo.com/
http://mail.yahoo.com/
https://mail.google.com/

)

view 1 On first logging in, you’ll see the

default layout for your emails,
roundcube ' & Contacts @ Calendar a Settings Webmail Home i . e . j u St a I iSt

Webmail — “Roundcube’

About admina@u3

corum.org () Logout

— oot 2 .
i o e o b There are many settings
£ inbox £+ Subject X  From Date Size N &
. . . .
/' Draft ] [U3a_webadmin] Digest on mike Sat 12:36 6 KB I bI th S tt g
a S:‘( = Re: [U3a_webadmin] Walkin.. Maureen Mgsffies sat 12:13 10 KB & ava I a e VI a e e I n S I CO n 14
- Re: (U3a_webadmin] Walkin mikg Sat11:54 108 & .
8 e Re- (033 webadmin alkin e Sac 1104 Y two that | use are d |Sp|ayed;
LI Deleted ltems [U3a_webadmin] Walking gr, U3A Dacorum - AdminA Sat 09:51 4xB &
B Archive Re: [U3a_webadmin] g R mike Fri12:37 21KB & Th P f IVI H | b V'
[U3a_webadmig d: Re: [ mike Fri 12:33 20 KB & e re e re n Ce s a I OX I eW >
[U3a_weamin] Fwd: [U3A mike Fri11:13 13 KB p .
(yp#fivebadmin] U3a Web s Terry Thirlwell 2019-11-18 15:30 & Layo ut IS Self eXpIa nato ry-
- = Select | & Threads | % Messages 1 to 28 of 28 1
o

Setting

secton In the Server Settings, using “Do not show deleted

I.‘ messages” removes them from the inbox to the
“Deleted Items” folder.

L] preferences

DISPPWIMG Messages

+
esponses 22

BPmposing Messages
24

] Spe.

In “Identities”, set up a signature block if you wish

Mailbox View

Main Option Widescreen (3-column view)

Desktop (wide list and mail previ server S%ings Edit identity
@ v List (no mail preview) e

. . Settings
Main Options
Mark messages as read immediately 5 Display Name
Mark the message as read deglete - "
i i = & T
On request for return receipt ask each time DRt et S
Evnand maccana thraade navar . Do not show deleted messages Reply-To
If moving messages 1o & o = 5 perete them - Bec
Set default
Directly delete messages in Junk
Mark the message as read on archive Signature

Maintenance Signature

Clear Trash on logout

HTML signature
Compact Inbox on logout



Webmail — “Roundcube” view 2

2

Reply

Double click on an email to view it.
From the email view, apart from the
obvious actions, reply, delete, etc.,

click on the More option for other

As well as forwarding an email, there is

— = - - —
.. oE T "F 7 ...
Reply all Forward Delete Move Print Archive Mark More (
[U3a_webadmin] Notes from Wednesday's meeting Message 14 of 27 |4 | | »
From U3A Dacorum - AdminA
Sender  u3a_webadmin H H
To  U3A Dacorum WebAdmin avallable actions.
Date 2019-11-15 16:39 v
Hi all
E Notes from Website 13 Nov 19...
Sorry, it took me a little white to put together. Hope it make: se.
Plea: let me know if you want any changfs, or change the document g track E Posts, Events and Pages VO0.1.... v
nges, and
a which may may not be

&y Print this message
¥ Download (.eml)
# Edit as new

<> Show source

¥ Move to...

-’ Copy to...

! Open in new window

[ Save as event

v

— == L —
. N K
Forward Delete Mol

Forward inline

Forward as attachment

also an option to “forward as
attachment”, useful if you want
someone else to get the “raw” email.
Clicking on the little down pointing
arrow opposite the date, displays the
raw headers — can be useful when
checking that an email is from the
sender!

Sender 1u3a wehadmin C||Ck the dOWh arrow by an
[U3a_webadmin] Notes from We... Melsage 14 of 27 (€] (> attachment to download |t

Sender u3a_webadmin
To U3A Dacorum WebAdmin
2019-11-15 16:39

Return-Path: <u3a_webadmin-bounces@u3adacorum.org>
Delivered-To: adniiNENEININNNN: .org
Received: from ssdserverl.layerip.com

by ssdserverl.layerip.com with LMTP

id AVvnD7DVzI2FugkAJ31yNQ

Date

Return-path: <u3a_webadmin-bounces@u3adacorum.org>
Envelope-to: ad i .or
Delivery-date: Fri, 15 Nov 2019 16:43:28 +0000

(envelope-from <u3a_webadmin-bounces@u3adacorum.org>)
for <admina@u3adacorum.org>; Fri, 15 Nov 2019 16:43:28 +0000

Received: from [::1] (port=52142 helo=ssdserverl.layerip.com)
by ssdserverl.layerip.com with esmtp (Exim 4.92)

A AN

B Notes from Website 13 Nov 19... v

= Posts, Events a
¥ Download

v oW s g9




Webmail — “Horde” view 1

horde Groupware 5.2.22

Calendar v

Address Book w

Tasks v Notes w

Others v cPanel Webmail Home

At first view, this is very
similar to Roundcube,

Help

Bookmarks
Calendar
Filters

Mail

Notes
Tasks

they read and reply to your
email.

Remote Accounts

Configure remote mail accounts
to display.

Saved Searches

Manage your saved searches

Filters

Create filtering rules to organize
your incoming mail, sort it into
mailboxes, and delete spam.

Event Requests

Configure how event or meeting
requests should be handled.

PGP
Configure PGP encryption
support.

S/MIME

Configure S/MIME encryption
support.

Compose Templates
Edit compose templates.

Replies
Configure how you reply to mail.

Drafts
Manage message drafts.

Sent Mail
Manage sent mail.

Address Books

Select address book sources for
adding/searching.

) Refresh dhth Filt HE H
O Refres R however, it is a bit more
From Subject ¥ Date ¥ Size
Q Drafts A Maureen Menzies [U3a_webadmin] Using Webmail 15:44:29 5KB * te C h n ica I !
m Sent @m mike [U3a_webadmin] Digest on web site 2311119 7KB
i Trosn a Maureen Menzies Re: [U3a_webadmin] Walking gro 2311119 11KB C I | C k| n g ont h e p refe rences
s mike 23/11/19 10 KB
P zme o | jcon and selecting Mail,
A U3A Dacorum - AdminA 23/11/19 5KB
— CE znne 2@ | displays quantities of
s mike 22/11/19 21KB
E S e mike 22/11/19 14 KB (o) pt|o ns |
LY WhREIAEIEE m Terry Thiriwell £badmin] U3a Web site databas.. 18/11/19 20KB
Preferences for Mail Show Advanced Preferences  Edit Preferences for: 4
General Compose Message Mailbox
Global Preferences b 9
Personal Informatio Viewing Mailbox Display
Toggle Alerts Log Address Book Change mename, address, and  Configure how you send mail. Configure how messages are Change display preferences for
signature that people see when displayed. viewing the listing of messages

in a mailbox.
Deleting and Moving
Messages
Set preferences for what
happens when you move and
delete messages.

Folder Display

Change folder navigation display
preferences.

Spam Reporting
Configure spam reporting.

New Mail

Control when new mail will be
checked for, and whether or not
to notify you when it arrives.

Flags
Configure flag highlighting.




Webmail — “Horde” view 2 “Personal Information”, among

Personal information F Forder Dispiay T Remete Accounts B other options, allows you to set

Your defaut centy up a more sophisticated
. signature block, if you wish, to
m"'y Compos be used when sending an HTML
3222.‘;‘:2‘:;” N gmall, including images and
[ g links and changes to the font
adminmSete——g

Your Reply-to: address: (optional) a n d CO I O U r-

Addresses to BCC all messages: (optional, enter each address on a new line)

To always send emails in HTML
format, open Preferences > Mail

Anne Menzies

U3A Dacorum Website Support / and SElect llcomposition” under

Precede your text signature with dashes (*--")?

Your signature to use when composing with the HTML editor (if empty, the text signature will be used) (maximum total image size is 30 KB): CAMmMnnco
B I U Aral 1. ¥ v A 4 BB e A% BOd O Preferences for Mail  snowAdvanced Preferences  Edit Preferences for: 4
Regards Composition |4 SIMIME | Compose Templates pj
Anne Menzies
U3A Dac‘qrum Website Support (# Click here to open all malilto: links using Mail.

Check spelling before sending a message?
Default method to compose messages:

v Plain Text
be located in the compose text area by default?
Save sem‘ mail? Top s
sesr:nTall mailbox: . Show the signature on the compose screen?
v

Your default encryption method for sending messages:

A
v

Compose messages in a separate window? (Basic view only)

Undo Changes Show All Preferences Groups Display confirmation in popup window after sending a message? (Basic view only)

Undo Changes Show All Preferences Groups



Webmail — “Horde” view 3

[ NON ) Mail :: New Message

& ssdserverl.layerip.com:2096/cpsess5655820415/hordefim...

= Send (& Check Spelling ¥ ‘ Q Save as Draft o
HTML composition

Save in Sent v
Priority: Normal »
Other Options ¥

0! | ittt G ui—
Add Cc Add Bce
Subject: Test from Horde

@ : Add Attachment ¥

Plain text

sdwmme@u@sdacorum.org
Test from Horde

To: Maureen Menzie

w

Plain Text

Regards
Anne Menzies
U3A Dacorum Website Support

Having clicked on
“New Message”,
you’ll be presented
with a blank
message. If you've
not set up to send in
HTML format you'll
see the one on the
left, otherwise on
the right. Note you
have the option to
select HTML
composition.

In the HTML version,
there are options to
format the text, add
images and links,
etc.

The received emails
are also shown.

[ ] O Mail :: New Message
& ssdserveri.layerip.com:2096/cpsess5655820415/horde/imp/dyna...
= Send (& Check Spelling v Q Save as Draft 0
HTML composition
[ Save in Sent v
Priority: Normal v

Other Options ¥

T —
Add Cc Add Bee
Subject:  Test from Horde

@ : Add Attachment ¥

B I U Anal 0 1 i v A~ B «
& BE® O 4
HTML|

admina@u3adacorum.org &
Test from Horde

To: Maureen Menzie

w

HTML

Regards
Anne Menzies
U3A Dacorum Website Support




